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RA Family, RX Family, RL78 Family 

FS1015 Sample Software Manual 

Introduction 

This application note describes the sample software that is for use with the FS1015 flow sensor and runs on 
certain MCUs of the RA family, RX family, and RL78 family. 

 

Target Devices 

RA6M4 Group 

RX65N Group 

RL78/G14 Group 

RL78/G23 Group 

 

Trademarks 

FreeRTOSTM and FreeRTOS.orgTM are trade marks of Amazon Web Services, Inc. 

Microsoft® Azure RTOS is trademarks of the Microsoft group of companies.  

All other trademarks are property of their respective owners. 
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1. Overview 

This sample software acquires data from the FS1015 flow sensor and handles calculations on the data. In 
combination with the I2C driver of the FSP or FIT or code generator, the sample software controls the 
FS1015 through the I2C in the MCU to acquire ADC data from the sensor and calculate the flow value. 

 

2. Environment for Confirming Operation 

2.1 Environment for Confirming Operation on the RA Family MCU 

The operation of this software has been confirmed on the MCU of the RA family in the following environment. 

 

Table 2-1  Operating Environment for RA Family 

Item Description 

Demonstration board RTK7EKA6M4S00001BE (EK-RA6M4) 

Microcontroller RA6M4 (R7FA6M4AF3CFB: 144pin) 

Operating frequency 200MHz 

Operating voltage 5V 

Integrated development environment e2 Studio 2023-01 

C compiler GCC 10.3.1.20210824 

IAR ANSI C/C++ Compiler V8.50.9.278/LNX for ARM 

ARM Compiler 6.16 

FSP V.3.8.0 

RTOS FreeRTOSTM / Microsoft® Azure RTOS 

Emulator On board (J-LINK) 

Interposer Interposer Board to convert Type2/3 to Type 6A PMOD standard 

(US082-INTERPEVZ) 

Sensor board PMOD Daughter Card for FS1015 flow sensor (US082-

FS1015EVZ) 

 

Table 2-2  Amount of Memory Used in RA Family 

Area Size (Non-OS) Size (FreeRTOS) Size (Azure RTOS) 

ROM 1,279 bytes 1,612 bytes 1,556 bytes 

RAM 73 bytes 353 bytes 422 bytes 

Memory size is calculated by functions and variables only related to FS1015 sensor. In RTOS, memory 
size does not include memory size of the thread. 

EK-RA6M4

PMOD2

Interposer
US082-

INTERPEVZ
Sensor Board 

1
Sensor Board 

2 

 

Figure 2-1  Hardware Connections for RA Family 
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2.2 Environment for Confirming Operation the RX Family MCU 

The operation of this software has been confirmed on the MCU of the RX family in the following environment. 

 

Table 2-3  Operating Environment for RX Family 

Item Description 

Demonstration board RPBRX65N (Envision Kit RX65N) 

Microcontroller RX65N (R5F565NEDDFB: 144pin) 

Operating frequency 12MHz 

Operating voltage 5V 

Integrated development environment e2 Studio 2023-01 

IAR EW for RX 4.20.1 

C compiler Renesas Electronics C/C++ compiler for RX family V.3.03.00 

GCC 8.3.0.202004 

IAR Toolchain for RX 8.4.10.7051 

FIT BSP V7.20 

RTOS FreeRTOSTM 

Emulator On board (E2OB) 

Interposer Interposer Board to convert Type2/3 to Type 6A PMOD standard 

(US082-INTERPEVZ) 

Sensor board PMOD Daughter Card for FS1015 flow sensor (US082-

FS1015EVZ) 

 

Table 2-4  Amount of Memory Used in RX Family 

Area Size (Non-OS) Size (FreeRTOS) Size (Azure RTOS) 

ROM 1,463 bytes 1,681 bytes 1,741 bytes 

RAM 145 bytes  205 bytes 414 bytes 

Memory size is calculated by functions and variables only related to FS1015 sensor. In RTOS, memory 
size does not include memory size of the thread. 

Envisionkit RX65N

PMOD

Interposer
US082-

INTERPEVZ
Sensor Board 

1
Sensor Board 

2 

 

Figure 2-2  Hardware Connections for RX Family 
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2.3 Environment for Confirming Operation on the RL78/G14 Group MCU 

The operation of this software has been confirmed on the MCU of the RL78/G14 Group in the following 
environment. 

 

Table 2-5  Operating Environment for RL78/G14 Group 

Item Description 

Demonstration board RTK5RLG140C00000BJ (RL78/G14 Fast Prototyping Board) 

Microcontroller RL78/G14 (R5F104MLAFB: 80pin) 

Operating frequency 32MHz 

Operating voltage 3.3V 

Integrated development environment e2 studio 2023-01 

IAR EW for RL78 4.21.1 

C compiler C compiler package for RL78 family V1.11.00 

GCC for Renesas RL78 4.9.2.202103 

IAR Toolchain for RL78 4.21.1.2409 

Emulator On board (E2OB) 

Sensor board PMOD Daughter Card for FS1015 flow sensor (US082-

FS1015EVZ) 

 

Table 2-6  Amount of Memory Used in RL78/G14 Group 

Area Size 

ROM 1,358 bytes 

RAM 92 bytes 

Fast Prototyping Board for RL78/G14

PMOD 2

Sensor Board 1 Sensor Board 2 

 

Figure 2-3  Hardware Connections for RL78/G14 Group 
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2.4 Environment for Confirming Operation the RL78/G23 Group MCU with 

The operation of this software has been confirmed on the MCU of the RL78/G23 Group in the following 
environment. 

 

Table 2-7  Operating Environment for the RL78/G23 Group MCU 

Item Description 

Demonstration board RTK7RLG230CSN000BJ (RL78/G23-128p Fast Prototyping 

Board) 

Microcontroller RL78/G23 (R7F100GSN2DFB :128pin) 

Operating frequency 32MHz 

Operating voltage 3.3V 

Integrated development environment e2 studio 2023-01 

IAR EW for RL78 4.21.1 

C compiler C compiler package for RL78 family V1.10.00 

LLVM for RL78 10.0.0.202209 

IAR Toolchain for RL78 4.21.1.2409 

Emulator E2 Lite 

Sensor board PMOD Daughter Card for FS1015 flow sensor (US082-

FS1015EVZ) 

 

Table 2-8  Amount of Memory Used in the RL78/G23 Group MCU 

Area Size 

ROM 1,683 bytes 

RAM 92 bytes 

 

Fast Prototyping Board for RL78/G23

PMOD 2

Sensor Board 1 Sensor Board 2 

 

Figure 2-4  Hardware Connections for the RL78/G23 Group 
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3. Sensor Specifications 

3.1 Overview of Sensor Specifications 

The following gives an overview of the specifications of the FS1015 flow sensor. 

 

Table 3-1  Overview of Sensor Specifications 

Item Description 

Air velocity range 0 to 7.23 (m/sec) 

Count range 409 to 3686 (numbers counted) 

Accuracy 5% (at 25C) 

Measurement time 125 (ms) 

I2C clock frequency 100 kHz and 400 kHz are supported. 

Slave address 0x50 

Addressing mode Only 7-bit addressing is supported. 

 

A value for air velocity is calculated from the value counted by the sensor according to the following curve. 

 

Figure 3-1  Relationship between the Values Counted by FS3000-1005 and Air Velocity 
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The following shows the relationship between the Air Velocity and Value Counted 

 

Table 3-2  Relationship between the Air Velocity and Value Counted 

 

 

 

3.2 Sensor Functions 

The FS1015 sample software supports the air velocity sensor (Part number: FS1015-1005). It does not 
support the FS1015-1015 sensor. 

The sensor begins measurement as soon as the power supply is turned on. 
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4. Sample Software Specifications 

This sample software package contains a total of eleven projects: non-OS and OS (FreeRTOS and Azure 
RTOS) versions for the RA family, non-OS and OS (FreeRTOS) versions for the RX family, and a non-OS 
version for the RL78 family. This section describes these projects. 

For the FreeRTOS settings for the RX family, refer to the FAQ. 

 

4.1 Configuration of the Sample Software 

Figure 4-1 is a block diagram of the sample software. 

 

Sample (DEMO) Software

FS1015 Software

I2C Driver (MCU driver)

I2C Communications Middleware

 

Figure 4-1  Block Diagram of the Sample Software 

 

4.2 Specifications of Sensor API Functions 

4.2.1 List of Sensor API functions 

 

The following table lists the sensor API functions. For details of the API functions, refer to the separately 
provided RX Family FS1015 Sensor API FIT Module application note (R01AN6048) and RL78 Family 
Renesas Sensor Control Modules application note (R01AN5896) 

 

Table 4-1  List of Sensor API Functions 

Function Description 

RM_FS1015_Open Starts control of the sensor. 

RM_FS1015_Close Terminates control of the sensor. 

RM_FS1015_Read Acquires data from the sensor. 

RM_FS1015_DataCalculate Calculates values from the data acquired from the sensor. 

 

  

https://en-support.renesas.com/knowledgeBase/category/30528/subcategory/30539
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4.2.2 Guide to Using the API Functions 

The following diagram of API function transitions shows the conditions on the usage of the individual FS1015 
API functions and the expected orders of function calls. 

RM_FS1015_Open

RM_FS1015_Close

RM_FS1015_Read

RM_FS1015_DataCalcu

late

(2)

(3) (4)

(5)

(6)

(7)

Flow No. Function Transition Case

(1) Start FS1015 not open FS1015  
(2) ADC Read open success
(3) calculate ADC read success (callback state success)
(4) next read ADC DataCalculate return success and next ADC data Get
(5) get retry ADC data user get retry ADC data or DataCalculate return invalid data
(6) Close FS1015 Error state or user stop
(7) Restart FS1015 Close success and user restart 
(8) Stop FS1015 Close success or Error

START

END

(1)

(8)

(6)

 

Figure 4-2  Diagram of Transitions between API Function Calls 

The conditions for calling the individual functions are shown below. 

• RM_FS1015_Open: (1) Activation of FS1015 or 
 (7) restart after a call of RM_FS1015_Close 

• RM_FS1015_Close: (6) Successful completion or abnormal end of individual processing 

• RM_FS1015_Read: (2) Acquisition of measured data after the start of measurement or 
 (5) retry after waiting for the response to the data acquisition request 

• RM_FS1015_DataCalculate: (3) Calculation of data after a call of RM_FS1015_Read 

Note: 

Since RM_FS1015_Open checks the state of the I2C driver, the I2C driver must be opened before the 
RM_FS1015_Open processing.  

Regarding how to open the I2C driver of the RA family and RX family, refer to the 
g_comms_i2c_bus0_quick_setup() function in the sample software. This is not necessary in the RL78 family 
devices because the I2C driver will be opened in the startup processing. 
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When using an OS and controlling the sensor with multiple threads or tasks simultaneously in use, the 
user will need to use a semaphore to control the bus. For the timing of the semaphore being raised and the 
control of blocking, refer to section 4.4, Flowchart of the OS Version of the Sample Software. 

 

4.3 Flowchart of the Main Processing in the Non-OS Version of the Sample Software 

This sample software first starts the driver and then repeats the processing for acquiring data from the 
sensor and calculating values from the results of measurement. 

 

While(!sensor_change)

FS1015 Open

Switch(sequence)

Read FS1015 ADC Data

Calculate data from ADC data

DEMO_SEQUENCE_3DEMO_SEQUENCE_1 DEMO_SEQUENCE_2

Switch(gs_demo_
callback_status)

sensor_change = true sequence = DEMO_SEQUENCE_1

DEMO_CALLBACK_ST
ATUS_WAIT

DEMO_CALLBACK_ST
ATUS_SUCCESS

DEMO_CALLBACK_ST
ATUS_REPEAT

Default

Default

A

R

Rsequence = DEMO_SEQUENCE_2

Return Error

A B

E

E

E

While(1)

E

Start

YES

NO

gs_demo_callback_status = 
DEMO_CALLBACK_STATUS_WAIT

demo_err

I2C Open

set delay period 125ms

DEMO_SEQUENCE_4

sequence = DEMO_SEQUENCE_4

DEMO_SEQUENCE_5

End delay period

NO

sensor_change = true

sequence = DEMO_SEQUENCE_4

YES

sensor_change = false

sequence = DEMO_SEQUENCE_3

 

Figure 4-3  Flowchart of the Main Processing in the Non-OS Version of the Sample Software (1) 
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Switch(Retuen)

sequence = DEMO_SEQUENCE_4

sequence = DEMO_SEQUENCE_1

FSP_SUCCESS
FSP_ERR_SENSOR_IN

VALID_DATA

Default

B

R

E

Callback

Args->event

gs_demo_callback_status = 
DEMO_CALLBACK_STATUS_

SUCCESS

gs_demo_callback_status = 
DEMO_CALLBACK_STATUS_

REPEAT

RM_FSXXXX_EVENT_
SUCCESS

other

END

Get data output_count
and flow_value

 

Figure 4-4  Flowchart of the Main Processing in the Non-OS Version of the Sample Software (2) 
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4.4 Flowchart of the OS Version of the Sample Software 

The OS version uses a semaphore in control of the sensor and operates one thread for controlling the 
sensor in parallel. 

The sensor control in the thread first starts the driver and then repeats the processing for acquiring data from 
the sensor and calculating values from the results of measurement. 

 

While(1)

FS1015 Open

Switch(sequence)

Read FS1015 ADC Data

Calculate data from ADC data

DEMO_SEQUENCE_3DEMO_SEQUENCE_1 DEMO_SEQUENCE_2

Default

R

sequence = 
DEMO_SEQUENCE_2

Return Error

A

B

E

E

Start
Thread

YES

NO

gs_demo_callback_status = 
DEMO_CALLBACK_STATUS_

WAIT

I2C Open
Create semaphore & mutex 

E

tx_thread_ delete()
 / vTaskDalete()

DEMO_SEQUENCE_4

sequence = 
DEMO_SEQUENCE_1

tx_thread_sleep()
/ vTaskDelay() : 409.6ms

 

Figure 4-5  Flowchart of the Main Processing in the OS Version of the Sample Software (1) 
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Switch(gs_demo_
callback_status)

sequence = 
DEMO_SEQUENCE_3

sequence = 
DEMO_SEQUENCE_1

DEMO_CALLBACK_
STATUS_WAIT

DEMO_CALLBACK_
STATUS_SUCCESS

DEMO_CALLBACK_
STATUS_REPEAT

Default

A

R

E

Switch(Retuen)

sequence = 
DEMO_SEQUENCE_4

sequence = 
DEMO_SEQUENCE_1

FSP_SUCCESS FSP_ERR_SENSOR_
INVALID_DATA

Default

B

R

E

Callback

Args->event

gs_demo_callback_status = 
DEMO_CALLBACK_STATUS_

SUCCESS

gs_demo_callback_status = 
DEMO_CALLBACK_STATUS_

REPEAT

RM_HS300X_EVENT_
SUCCESS

other

END

tx_thread_sleep()
/ vTaskDelay() : 1ms

 

Figure 4-6  Flowchart of the Main Processing in the OS Version of the Sample Software (2) 
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4.5 Azure RTOS Project 

The RX Azure RTOS project has the following changes from the default. 

1. src/demo_thread.c 

Line 57: Addition of extern void tx_application_define_user (void); 

Line 178: Addition of tx_application_define_user(); 

2. libs/threadx/common/inc/tx_api.h 

Line 224: Change of TX_TIMER_TICKS_PER_SECOND ((ULONG) 1000) 
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5. Configuration Settings 

5.1 FS1015 Flow Sensor Settings 

5.1.1 RA Family 

Select the rm_fs1015 stack in the "Stack" tabbed page of the FSP Configurator, and the configurable items 
are shown in the "Properties" tabbed page. 

The following items and values can be specified. 

 

Table 5-1  FS1015 Settings for RA Family 

Configurable Item Value Description 

Common 

Parameter Checking Default (BSP) Enable or disable the parameter check 
processing. 
When "Enabled" is selected, the project is built 
so that the generated code includes the 
parameter check processing. 

Enabled 

Disabled 

Device type FS1015-1005 Specify the type of sensor. 

Module g_fs1015_sensor FS1015 on rm_fs1015 
Name g_fs1015_sensor0 Specify the name of the module. 

A module name conforming to the C language 
standard can be specified. 

Callback fs1015_callback Specify the name of the user callback function. 
A callback function name conforming to the C 
language standard can be specified. 
When "NULL" is specified, no callback function 
is used. 
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5.1.2 RX Family 

Select the r_fs1015_rx component in the "Component" tabbed page of the Smart Configurator, and the 
configurable items are shown in the "Configure" panel. 

The following items and values can be specified. 

 

Table 5-2  FS1015 Settings for RX Family 

Configurable Item Value Description 

Configurations 

Parameter Checking System Default  Enable or disable the parameter check 
processing. 
When "Enabled" is selected, the project is built 
so that the generated code includes the 
parameter check processing. 

Enabled 

Disabled 

Number of FS3000 
sensors 

1 Specify the number of FS1015 sensors to be 
connected. 2 

Device type of 
FS1015 Sensors 

FS1015-1005 Specify the type of sensor.  
"FS1015-1005" can be selected. 

Using 
communication line 
number for FS1015 
sensor device x 
(x = 0 or 1) 

I2C Communication Device(y)  
(y = 0 - 15) 

Specify the communication line to be used by 
the sensor. 

Callback function for 
FS1015 sensor 
device x 
(x = 0 or 1) 

fs1015_user_callback(x) 
(x = 0 or 1) 

Specify the name of the user callback function. 
A callback function name conforming to the C 
language standard can be specified. 
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5.1.3 RL78 Family 

Settings can be modified by changing the values of the constants defined in the 
\r_config\r_fs1015_rl_config.h file in the project tree of the sample project. 

The following items and values can be specified. 

 

Table 5-3  FS1015 Settings for RL78 Family 

Constant Name Value Description 

Configurations 

RM_FS1015_CFG_PARAM_
CHECKING_ENABLE 

0 Enable (1) or disable (0) the parameter 
check processing. 
When "1" is specified, the project is built 
so that the generated code includes the 
parameter check processing. 

1 

RM_FS1015_CFG_DEVICE_
NUM_MAX 

1 Specify the number of FS1015 sensors to 
be connected. 2 

RM_FS1015_CFG_DEVICE_
TYPE 

RM_FS1015_DEVICE_TYP
E_1005 

Specify the type of sensor.  
"FS1015-1005" can be selected. 

RM_FS1015_CFG_DEVICE(x
)_COMMS_INSTANCE 
(x = 0 or 1) 

g_comms_i2c_device(x) 
(x = 0 or 1) 

Specify the instance name of the 
communication line to be used. 

RM_FS1015_CFG_DEVICE(x
)_CALLBACK  
(x = 0 or 1) 

fs1015_user_callback(x) 
(x = 0 or 1) 

Specify the name of the user callback 
function. 
A callback function name conforming to 
the C language standard can be specified. 
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5.2 Communication Driver Middleware Settings 

5.2.1 RA Family 

Select the rm_comms_i2c stack in the "Stack" tabbed page of the FSP Configurator, and the configurable 
items are shown in the "Properties" tabbed page. 

The following items and values can be specified. 

 

Table 5-4  Communication Driver Settings for RA Family 

Configurable Item Value Description 

Common 

Parameter Checking Default (BSP) Enable or disable the parameter check 
processing. 
When "Enabled" is selected, the project is built 
so that the generated code includes the 
parameter check processing. 

Enabled 

Disabled 

Module g_comms_i2c_device I2C Communication Device on 
rm_comms_i2c 
Name g_comms_i2c_device0 Specify the name of the module. 

A module name conforming to the C language 
standard can be specified. 

Semaphore Timeout 0xFFFFFFFF For an RTOS project, specify the time of 
semaphore timeout. 

Slave Address 0x50 Specify the slave address. 
When rm_fs1015 is used, this value is 
automatically specified and cannot be modified. 

Address Mode 7-Bit Specify the number of slave address bits. 
When rm_fs1015 is used, this value is 
automatically specified and cannot be modified. 

Callback rm_fs1015_callback Specify the name of the user callback function. 
When rm_fs1015 is used, this value is 
automatically specified and cannot be modified. 

Module g_comms_i2c_bus0 I2C Shared Bus on rm_comms_i2c 
Name g_comms_i2c_bus0 Specify the name of the I2C module. 

Bus Timeout 0xFFFFFFFF Specify the time of I2C bus timeout. 

Semaphore for 
blocking 

Unuse For an RTOS project, enable or disable the 
blocking processing. Use 

Recursive Mutex for 
Bus 

Unuse For an RTOS project, enable or disable the 
recursive operation when blocking is enabled. Use 
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5.2.2 RX Family 

Select the r_comms_i2c_rx component in the "Component" tabbed page of the Smart Configurator, and the 
configurable items are shown in the "Configure" panel. 

The following items and values can be specified. 

 

Table 5-5  Communication Driver Settings for RX Family 

Configurable Item Value Description 

Configurations 
Parameter Checking System Default  Specify whether to include the processing to 

check parameters in the code to be generated.  
When "Disabled" is selected, the generated 

code does not include the processing to check 
parameters. 

When "Enabled" is selected, the generated 

code includes the processing to check 

parameters. 

Enabled 

Disabled 

Number of I2C Shared 

Buses 

Unused Specify the number of I2C bus lines that can be 

connected. 1 

2 – 16 

Number of I2C Devices Unused Specify the number of I2C devices that can be 

connected. 1 

2 – 16 

Blocking operation 

supporting with RTOS 

Disabled For an RTOS project, enable or disable the 

blocking operation. Enabled 

Bus lock operation 

supporting with RTOS 

Disabled For an RTOS project, enable or disable the bus 

lock operation. Enabled 

IIC Driver Type for I2C 
Shared bus(x) 

(x = 0 – 15) 

RIIC Specify the I2C type to be used for the 
communications bus. 

Using the RIIC requires r_riic_rx. Using the 
SCI IIC requires r_sci_iic_rx. 

If an unused FIT module is deleted, a warning 

message will appear but this will not affect the 

operation. 

SCI IIC 

Not selected 

Channel No. for I2C 
Shared bus(x) 

(x = 0 – 15) 

0 Specify the I2C channel number to be used for 

the communications bus.  

Timeout for the bus 
lock of the I2C bus for 
I2C Shared Bus(x) 

(x = 0 – 15) 

0xFFFFFFFF Specify the time of I2C bus lock timeout for 
I2C bus x. 

(x = 0 – 15) 

I2C Shared Bus No. for 
I2C Communication 
Device(x) 

(x = 0 – 15) 

I2C Shared Bus(x) 
(x = 0 – 15) 

Specify the configuration of the I2C bus to be 
used for the communications bus.  

Slave address for 
communication device(x) 

(x = 0 – 15) 

0x50 Specify the slave address of the device to be 

connected to the communications bus. 

When using r_fs1015_rx, specify 0x50. 

Slave address mode 
for communication 
device(x) 

(x = 0 – 15) 

7 bit address mode Specify the slave address mode. 

When using r_ fs1015_rx, specify the 7-bit 

address mode. 

Callback function for 
Communication device(x) 

(x = 0 – 15) 

comms_i2c_user_callbac
k(x) 

(x = 0 – 15) 

Specify the name of the user callback 
function. 

When using r_ fs1015_rx, specify rm_ 

fs1015_callback(y) (y = 0). 
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5.2.3 RL78 Family 

Settings can be modified by changing the values of the constants defined in the 
\r_config\r_comms_i2c_rl_config.h file in the project tree of the sample project. 

The following items and values can be specified. 

 

Table 5-6  Communication Driver Settings for RL78 Family 

定数名 設定値 説明 

Configurations 

COMMS_I2C_CFG_PARA
M_CHECKING_ENABLE 

0 Enable (1) or disable (0) the 
parameter check processing. 
When "1" is selected, the project is 
built so that the generated code 
includes the parameter check 
processing. 

1 

COMMS_I2C_CFG_BUS_N
UM_MAX 

1 Specify the number of 
communication bus lines that can be 
connected. 

2 

3 

4 

5 

COMMS_I2C_CFG_DEVIC
E_NUM_MAX 

1 Specify the number of I2C devices 
can be connected. 

2 

3 

4 

5 

COMMS_I2C_CFG_BUS(x)
_DRIVER_TYPE  
(x = 0 - 4) 

COMMS_DRIVER_I2C Specify the I2C type to be used for 
the communication bus. 

COMMS_DRIVER_SAU_I2C 

COMMS_I2C_CFG_DEVIC
E(x)_BUS_CH 
(x = 0 - 4) 

g_comms_i2c_bus(x)_extended_cf
g 
(x = 0 - 4) 

Specify the I2C bus configuration to 
be used for the communication bus. 

COMMS_I2C_CFG_DEVIC
E(x)_SLAVE_ADDR  
(x = 0 - 4) 

0x50 Specify the slave address of the 
device to be connected to the 
communication bus. 
When using rm_fs1015, specify 
0x50. 

COMMS_I2C_CFG_DEVIC
E(x)_CALLBACK 
(x = 0 - 4) 

comms_i2c_user_callback(x) 
(x = 0 - 4) 

Specify the name of the user callback 
function. 
When using rm_fs1015, specify 
rm_fs1015_callback(y) (y = 0). 
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5.3 I2C Driver Settings 

5.3.1 RA Family 

Select the r_iic_master or r_sci_i2c stack in the "Stack" tabbed page of the FSP Configurator, and the 
configurable items are shown in the "Properties" tabbed page. 

The following items and values can be specified. 

 

Table 5-7  r_iic_master Settings for RA Family 

Configurable Item Value Description 

Common 

Parameter Checking Default (BSP) Enable or disable the parameter check 
processing. 
When "Enabled" is selected, the project is built 
so that the generated code includes the 
parameter check processing. 

Enabled 

Disabled 

DTC on 
Transmission and 
Reception 

Enabled Specify whether to use the DTC for transmission 
and reception. 

Disabled 

10-bit slave 
addressing 

Enabled Specify whether to support 10-bit addressing for 
the slave address. 
When using rm_fs1015, select "Disabled".  

Disabled 

Module g_i2c_master0 I2C Master Driver on r_iic_master 
Name g_i2c_master0 Specify the name of the module. 

Channel 0 Specify the channel number to be used. 

Rate Standard Specify the baud rate. 
When using rm_fs1015, select "Standard" or 
"Fast-mode". 

Fast-mode 

Fast-mode plus 

Rise Time (ns) 120 Specify the SCL rise time according to the 
specifications of the target board to be used. 

Fall Time (ns) 120 Specify the SCL fall time according to the 
specifications of the target board to be used. 

Duty Cycle (%) 50 Specify the SCL duty cycle. 

Slave Address 0x00 This item specifies the slave address of the 
device to be connected but the user does not 
need to make this setting because 
rm_comms_i2c overwrites it. 

Address Mode 7-Bit This item specifies the salve address mode for 
the device to be connected but the user does 
not need to make this setting because 
rm_comms_i2c overwrites it. 

10-Bit 

Timeout Mode Short Mode Specify the time of I2C bus timeout. 

Long Mode 

Callback rm_comms_i2c_callback The name of the user callback function is 
automatically specified by rm_comms_i2c. 
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Interrupt Priority 
Level 

Priority 0 (highest) Specify the interrupt priority level of the I2C bus 
driver. 

Priority 1 

Priority 2 

Priority 3 

Priority 4 

Priority 5 

Priority 6 

Priority 7 

Priority 8 

Priority 9 

Priority 10 

Priority 11 

Priority 12 

Priority 13 

Priority 14 

Priority 15 

Pins 
SDA Pxxx The pin numbers to be used by the driver are 

displayed 
Use the "Pins" tabbed page to modify the pin 
configuration. 

SCL Pxxx 
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Table 5-8  r_sci_i2c Settings for RA Family 

Configurable Item Value Description 

Common 

Parameter Checking Default (BSP) Enable or disable the parameter check 
processing. 
When "Enabled" is selected, the project is built 
so that the generated code includes the 
parameter check processing. 

Enabled 

Disabled 

DTC on 
Transmission and 
Reception 

Enabled Specify whether to use the DTC for transmission 
and reception. 

Disabled 

10-bit slave 
addressing 

Enabled Specify whether to support 10-bit addressing for 
the slave address. 
When using rm_fs1015, select "Disabled". 

Disabled 

Module g_i2c0 I2C Master Driver on r_sci_i2c 
Name g_i2c0 Specify the name of the module. 

Channel 0 For an RTOS project, specify the time of 
semaphore timeout. 

Slave Address 0x00 This item specifies the slave address of the 
device to be connected but the user does not 
need to make this setting because 
rm_comms_i2c overwrites it. 

Address Mode 7-Bit This item specifies the salve address mode for 
the device to be connected but the user does 
not need to make this setting because 
rm_comms_i2c overwrites it. 

10-bit 

Rate Standard Specify the baud rate. 
Select "Standard" or "Fast-mode". 

Fast-mode 

Fast-mode plus 

SDA Output Delay 
(nano seconds) 

300 Specify the SDA output delay time. 

Noise filter setting Use clock signal divided by 1 
with noise filter 

Specify the noise filter to be used for input 
signals. 

Use clock signal divided by 2 
with noise filter 

Use clock signal divided by 4 
with noise filter 

Use clock signal divided by 8 
with noise filter 

Bit Rate Modulation Enable Enable or disable the bit rate modulation 
function. Disable 

Callback rm_comms_i2c_callback The name of the user callback function is 
automatically specified by rm_comms_i2c. 
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Interrupt Priority 
Level 

Priority 0 (highest) Specify the interrupt priority level of the I2C bus 
driver. Priority 1 

Priority 2 

Priority 3 

Priority 4 

Priority 5 

Priority 6 

Priority 7 

Priority 8 

Priority 9 

Priority 10 

Priority 11 

Priority 12 

Priority 13 

Priority 14 

Priority 15 

RX Interrupt Priority 
Level [Only used 
when DTC is 
enabled] 

Priority 0 (highest) When using the DTC, specify the priority level of 
the reception interrupt. Priority 1 

Priority 2 

Priority 3 

Priority 4 

Priority 5 

Priority 6 

Priority 7 

Priority 8 

Priority 9 

Priority 10 

Priority 11 

Priority 12 

Priority 13 

Priority 14 

Priority 15 

Disabled 

Pins 
SDA Pxxx The pin numbers to be used by the driver are 

displayed 
Use the "Pins" tabbed page to modify the pin 
configuration. 

SCL Pxxx 
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5.3.2 RX Family 

Select the r_riic_rx or r_sci_iic_rx component in the "Component" tabbed page of the Smart Configurator, 
and the configurable items are shown in the "Configure" panel. 

The following items and values can be specified. 

 

Table 5-9  r_riic_rx Settings for RX Family 

Configurable Item Value Description 

Configurations 

Set parameter 
checking enable 

System Default Enable or disable the parameter check processing. 
When "Include" is selected, the project is built so 
that the generated code includes the parameter 
check processing. 

Not 

Include 

MCU supported 
channels for CHx 
(x = 0 – 2) 

Not supported Specify whether to support the operation of channel 
x. Supported 

CHx RIIC bps(kbps) 
(x = 0 – 2) 

400 Specify the baud rate. 
Set to 400 or a smaller value. 

Digital filter for CHx 
(x = 0 – 2) 

Not Specify the digital filter for input signals. 

One IIC phi 

Two IIC phi 

Three IIC phi 

Four IIC phi 

Setting port setting 
processing 

Not include port setting Specify whether to include the pin function settings 
in the code to be generated. Include port setting 

Master arbitration lost 
detection function for 
CHx 
(x = 0 – 2) 

Unused Specify whether to use the master arbitration lost 
detection function. Used 

Address y format for 
CHx 
(x = 0 – 2, y = 0 – 2) 

Not This item specifies the slave address mode for 
slave address y but the user does not need to make 
this setting because rm_comms_i2c overwrites it. 

7 bit address format 

10 bit address format 

Slave Address y for 
CHx 
(x = 0 – 2, y = 0 – 2) 

0x0025 This item specifies slave address y but the user 
does not need to make this setting because 
rm_comms_i2c overwrites it. 

General call address 
for CHx 

Unused Specify whether to use the general call function. 

Used 

CHx RXI INT Priority 
Level 
(x = 0 – 2) 

Level 1 Specify the priority level of the reception interrupt. 

Level 2 

Level 3 

Level 4 

Level 5 

Level 6 

Level 7 

Level 8 

Level 9 

Level 10 

Level 11 

Level 12 

Level 13 

Level 14 

Level 15 (highest) 
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CHx RXI INT Priority 
Level 
(x = 0 – 2) 

Level 1 Specify the priority level of the transmission 
interrupt. Level 2 

Level 3 

Level 4 

Level 5 

Level 6 

Level 7 

Level 8 

Level 9 

Level 10 

Level 11 

Level 12 

Level 13 

Level 14 

Level 15 (highest) 

CHx EEI INT Priority 
Level 
(x = 0 – 2) 

Level 1 Specify the priority level of the error interrupt. 

Level 2 

Level 3 

Level 4 

Level 5 

Level 6 

Level 7 

Level 8 

Level 9 

Level 10 

Level 11 

Level 12 

Level 13 

Level 14 

Level 15 (highest) 

CHx TEI INT Priority 
Level 
(x = 0 – 2) 

Level 1 Specify the priority level of the transmission end 
interrupt. Level 2 

Level 3 

Level 4 

Level 5 

Level 6 

Level 7 

Level 8 

Level 9 

Level 10 

Level 11 

Level 12 

Level 13 

Level 14 

Level 15 (highest) 
Timeout function for CHx 
(x = 0 – 2) 

Unused Specify whether to use the timeout function. 

Used 
Timeout detection time 
for CHx 
(x = 0 – 2) 

Long mode Specify the time for timeout detection. 

Short mode 

Count up during low 
period of timeout 
detection for CHx 
(x = 0 – 2) 

Unused Specify whether to increment the count for 
detecting a timeout while SCL is at the low level. Used 

Count up during high 
period of timeout 
detection for CHx 
(x = 0 – 2) 

Unused Specify whether to increment the count for 
detecting a timeout while SCL is at the high level.  Used 
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Set Counter of 
checking bus busy 

1000 Specify the count to detect the bus busy state. 

Resources 

SDAx Pins Checked Specify the pins to be used. 
Select the checkboxes for the desired pins. 

SCLx Pins Checked 

 

Table 5-10  r_sci_iic_rx Settings for RX Family 
Configurable Item Value Description 

Configurations 

Set parameter 
checking enable 

System Default Enable or disable the parameter check processing. 
When "Include" is selected, the project is built so 
that the generated code includes the parameter 
check processing. 

Not 

Include 

MCU supported 
channels for CHx 
(x = 0 – 12) 

Not supported Specify whether to support the operation of channel 
x. Supported 

SCI IIC bitrate (bps) 
for CHx 
(x = 0 – 12) 

384000 Specify the baud rate. 
Set to 384000 or a smaller value. 

Interrupt Priority for 
CHx 
(x = 0 – 12) 

Level 1 Specify the interrupt priority level. 

Level 2 

Level 3 

Level 4 

Level 5 

Level 6 

Level 7 

Level 8 

Level 9 

Level 10 

Level 11 

Level 12 

Level 13 

Level 14 

Level 15 (highest) 

Digital noise filter 
(NFEN bit) for CHx 
(x = 0 – 12) 

Disable Specify whether to use the digital noise filter. 

Enable 

Noise Filter Setting 
Register (NFCS bit) 
for CHx 
(x = 0 – 12) 

The clock divided by 1 Specify the function of the digital noise filter. 

The clock divided by 2 

The clock divided by 4 

The clock divided by 8 

I2C Mode Register 1 
(IICDL bit) for CHx 
(x = 0 – 12) 

18 Specify the number of SDA output delay cycles. 

Software bus busy 
check counter 

1000 Specify the count to detect the bus busy state. 

Setting port setting 
processing 

Not include port setting Specify whether to include the pin function settings 
in the code to be generated. Include port setting 

Resources 

SSDAx Pins Checked Specify the pins to be used. 
Select the checkboxes for the desired pins. SSCLx Pins Checked 
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5.3.3 RL78 Family 

Select "Serial" from the peripheral functions in the Code Generator, and the configurable items are shown in 
the "Peripheral Functions" tabbed page. 

The following items and values can be specified. 

 

Table 5-11  Serial Settings for RL78 Family 

Configurable Item Value Description 

SAUx 

Channel 

Channel x Unused Specify the communication function of the 
channel to be used. 
When using r_fs1015, select IICxx. 

UARTxx 

CSIxx 

IICxx 

IICxx 

Transfer rate 1000000 Specify the baud rate. 
When using rm_fs1015, specify 100000. 

Transfer end interrupt 
priority (INTIICxx) 

High Specify the priority level of the transfer end 
interrupt.  Level1 

Level2 

Low 

Master transmission 
end 

Checked Specify whether to use the call back function 
when master transmission ends. 

Master reception end Checked Specify whether to use the call back function 
when master reception ends. 

Master error Checked Specify whether to use the call back function 
when a communication error occurs. 

IICAx 

Transfer mode 

Transfer mode Unused Specify the communication function of the 
channel to be used. 
Select "Single master". 

Single master 

Slave 

Setting 

Clock mode setting fCLK Specify the clock for counting. 
 fCLK/2 

Address 16 Specify the local address. 

Operation mode 
setting 

Standard Specify the operating mode. 

Fast mode/Fast mode plus 

Transfer clock (fSCL) 100000 Specify the baud rate. 
Set to 400000 or a smaller value. 

Communication end 
interrupt priority 
(INTIICAx) 

High Specify the priority level of the communication 
end interrupt.  Level1 

Level2 

Low 

Master transmission 
end 

Checked Specify whether to use the call back function 
when master transmission ends. 

Master reception end Checked Specify whether to use the call back function 
when master reception ends. 

Master error Checked Specify whether to use the call back function 
when a communication error occurs. 

Generated stop 
condition in master 
transmission/reception 
end callback function 

Checked Specify whether to generate a stop condition in 
a callback. 
Deselect the checkbox. 
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6. Guide for Changing the Target Device 

Use the following procedures to change the target device to a new one and run a sample project on the new 
device. 

Before switching to a new device, import the original sample project for the current device to the workspace. 

 

6.1 RA Sample Project 

Use the following procedures to modify a sample project. 

This section describes an example of modifying the sample project "FS1015_RA6M4_NonOS" so that it can 
be used on the EK-RA2E1 board. 

The description of PMOD1 is the procedure when using a board to which "OptionType6A" is applied. 

 

6.1.1 Importing the Sample Project 

Select [Import] from the menu. 

The "Import" window will appear. Select "Rename & Import Existing C/C++ Project into Workspace" in the 
window and press the [Next] button. 
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Press the [Browse] button to open the "Select Folder" window. 

Select the folder of the original project for the current device from a list of imported sample projects and 
press the [Select Folder] button. 

 

 

Enter the project name, select the original project for the current device, and press the [Finish] button 

 



RA Family, RX Family, RL78 Family FS1015 Sample Software Manual 

R01AN6049EJ0103  Rev.1.03  Page 32 of 63 

September 7, 23  

6.1.2 Modifying Settings of the FSP Configurator 

Double-click on "Configuratorn.xml" in the project tree to open the FSP Configurator. 

Change the settings of "Board" and "Device" in the "BSP" tabbed page. 

When selecting a Renesas board, modify the "Board" setting only. 

When selecting a board provided from other companies, change the "Board" setting to "Custom User Board 
(Any Device)" and then change the "Device" setting to the new device to be used. 

 

 

Set up the clocks in the "Clocks" tabbed page. 

When "Custom User Board (Any Device)" is selected for "Board", set up the clocks according to the 
specifications of the target board to be used. 

When a Renesas board is selected for "Board", the clocks are automatically set up. 
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In the “Pins” tabbed page, modify the pin configuration according to the specifications of the target board to 
be used. 

When using a Renesas board, change the selection for "Select Pin Configuration" from ”RA6M4 EK” to the 
target board; appropriate pins are automatically assigned. 

 

 

If the desired board is not displayed in the drop-down list for "Select Pin Configuration", click on [Manage 
Configuration] to open the "Manage Pin Configuration" window and select the desired board in the window.  
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However, the "Select Pin Configuration" assignment will apply the SPI communication pin settings that 
support PMOD Type 2A on the EK-RA2E1 board. 

This sample software uses PMOD Type 6A, therefore it is necessary to change the I2C communication pin 
settings that support PMOD Type 6A.  

 

SCI2 is assigned to PMOD1 and SCI1 to PMOD2 on the EK-RA2E1 board.  

I2C communication is assigned to P301 and P302 on PMOD1(OptionType6A), and it is assigned to P401 
and P402 on PMOD2.  

After automatic assignment of "Select Pin Configuration", reconfigure in "Pin Configuration". 
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To enable generation of pin settings, check [Generate data] check-box and enter a desired name in the text 
field.  

The entered name is linked to the pin configuration, therefore must use a unique name that does not 
duplicate with other pin configurations. 

In our example, it is ”g_bsp_pin_cfg_2e1”. 
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Modify the configuration of individual components in the "Stacks" tabbed page. 

Modify the settings of r_iic_master or r_sci_i2c according to the specifications of the target board. 

To use the pins of the IIC, delete the "I2C Master Driver on r_sci_i2c" stack and then add the "I2C Master 
Driver on r_iic_mster" stack. 

SCI2 is assigned to PMOD1 and SCI1 is assigned to PMOD2 on the EK-RA2E1 board. 

To use PMOD1, set "Channel" to "2". To use PMOD2, set to "1". 
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Enter the pin configuration name to use in "Pin Configuration Name" of "g_ioport I/O Port". 

In our example, it is ”g_bsp_pin_cfg_2e1”. 

 

 

If an error is displayed in other stacks, modify the specified item according to the displayed error. 

 

Press [Generate Project Content] to generate files. 

Build the project. 

Select [Debug Configurations] from the menu and modify the debugger settings according to the 
specifications of the emulator to be connected to the target board. 

 

6.1.3 Changing toolchain setting 

If you want to use a toolchain other than the GCC ARM Embedded toolchain, copy RA_FS1015.c (Non-
OS) or fs1015_sensor_thread_entry.c, sensor_thread_common.c, and sensor_thread_common.c 
(FreeRTOS, Azure) from this project to create a new project. 
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6.2 RX Sample Project 

Use the following procedures to modify a sample project. 

This section describes an example of modifying the sample project "FS1015_RX65N_NonOS" so that it can 
be used on the RSKRX231 board. 

 

6.2.1 Importing the Sample Project 

Select [Import] from the menu. 

The "Import" window will appear. Select "Rename & Import Existing C/C++ Project into Workspace" in the 
window and press the [Next] button. 

 

 

Press the [Browse] button to open the "Select Folder" window. 

Select the folder of the original project for the current device from a list of imported sample projects and 
press the [Select Folder] button. 
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Enter the project name, select the original project for the current device, and press the [Finish] button. 

 



RA Family, RX Family, RL78 Family FS1015 Sample Software Manual 

R01AN6049EJ0103  Rev.1.03  Page 40 of 63 

September 7, 23  

6.2.2 Changing the Device 

Select the imported project from the project tree and right-click on int to open the context menu. Select 
"Change Device" from the menu. 

 

 

Select a desired board or device in the "Change Device" window and press the [Next] button. 
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If a warning message appears, read it and check if there is a problem in proceeding with the procedure. 
Press [Next] to move to the next step. 

 

 

The changes you have made in the settings will be displayed. Press the [Finish] button to apply the changes 
to the project. 
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6.2.3 Modifying Settings of the Smart Configurator 

On the project tree, double-click on the .scfg file of the imported project in which the target device has been 
changed; the Smart Configurator window will open. 

 

 

Select the "Board" tabbed page to check that the board and device have been changed correctly. 

 

 

Set up the clocks in the "Clocks" tabbed page according to the specifications of the target board to be used. 
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Modify the settings of individual components in the "Components" tabbed page according to the 
specifications of the target board. 

As SCI8 is assigned to PMOD on the RSK RX231 board, change the setting of "MCU supported channels for 
CH2" to "Not supported" and "MCU supported channels for CH8" to "Supported" in r_sci_iic_rx. 

Check the settings of "SSCL8 Pin" and "SSDA8 Pin" for "SCI8" under "Resources". 

     

 

Open the "Pins" tabbed page and check that functions are assigned to the SCI8 pins in the "Pin function" 
panel. 

 

 

As the use of PMOD Type 2A (extended SPI) is specified in the RSK RX231 board information, a warning 
message will appear when I2C is used, but this does not produce any problems. 

To connect a sensor board, a board for converting PMOD Type 2A to PMOD Type 6A is necessary. 
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Press the [Generate Code] icon to generate code. 

 

 

Build the project.  

Select [Debug Configurations] from the menu and modify the debugger settings according to the 
specifications of the emulator to be connected to the target board. 

 

6.2.4 Changing toolchain setting 

If you want to use a toolchain other than the CC-RX toolchain, copy RA_FS1015.c (Non-OS), or main.c 
and fs1015_sensor_thread_entry.c (FreeRTOS), or fs1015_sensor_thread_entry.c, 
sensor_thread_common.c, and sensor_thread_common.c (Azure) from this project to create a new project. 
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6.3 RL78 Sample Project 

Changing the target device within the RL78 family requires creating a new project. 

This section describes an example of creating a new project that can be used on the RSK RL78/G1G board. 

 

6.3.1 Creating a New Project 

Select [File] → [New] → [Renesas C/C++ project] → [Renesas RL78] from the menu. 

Select the template "Renesas CC-RL C Executable Project” and press the [Next] button. 

 

 

Enter the project name (example: "FS1015_RL78G1G_NonOS") and press the [Next] button. 
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Change "Target Device" to a desired device (example: R5F11EFA) and press the [Next] button. 

  

 

Select the checkbox for "Use Peripheral Code Generator" and press the [Next] button. 

 

 

Press the [Finish] button. 
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6.3.2 Settings of the Code Generator 

Modify the pin assignment in the "Pin assignment" tabbed page for "Common/Clock Generator" according to 
the specifications of the target board to be used. 

 

 

Modify the clock settings in the "Clock setting" tabbed page for "Common/Clock Generator" according to the 
specifications of the target board. 
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Select "Used" for "On-chip debug operation setting" in the "On-chip debug setting" tabbed page for 
"Common/Clock Generator". 

 

 

To use the serial array unit, set the channel assigned to PMOD on the target board to "IICxx" in the "Serial 
Array Unit" or "Serial" tabbed page. 

Note: The corresponding pin must be selected as N-ch by "Port". 
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In the tabbed page for IICxx enabled in the serial array unit, set "Transfer rate" to 400000 or 100000, set 
"Transfer end interrupt priority" to a desired value, and enable all functions under "Callback function setting". 
Note : When using a serial array unit, the Nch open drain of the pin to be used is set automatically. If an error 
icon on the port was displayed, open the Ports tab and check the port settings. 

 

 

To use the serial interface IICA, select "Single master" in the "Transfer mode" tabbed page for the channel 
assigned to PMOD on the target board in the "Serial Interface IICA" or "Serial" setting window.  
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In the "Setting" tabbed page for the channel set to the single master, set "Operation mode setting" to either a 
combination of "Fast mode" and "400000" or a combination of "Standard" and 100000, set the interrupt 
priority to a desired level, enable all functions under "Callback function setting", and disable "Callback 
function enhanced feature setting". 

 

 

On the [General setting] tabbed page for a desired channel of the timer array unit or a desired TAU of the 
timer, select "Interval timer" under "Functions". 
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In the page for the channel set to the interval timer, set "Interval value" to "100 µs", enable timer interrupts, 
and set the interrupt priority to a desired level. 

 

 

Press the [Code Generate] button to generate code. 

 

6.3.3 Modifying the Generated Code 

Perhaps Code Generator output destination different from this sample software, because Code Generator 
version differs depending on the MCU used. 
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Open r_cg_sau_user.c, r_cg_iica_user.c, or r_cg_serial_user.c and add the following code. 

Definition for including r_comms_i2c_if.h: 

 

 

Addition of the rm_comms_i2c_bus0_callback() function to the callback function: 

Specify the "false" parameter for the transmission and reception end callback functions and the "true" 
parameter for the error callback function. 

 

 

  

/************************************************************************* 

* Function Name: r_iic00_callback_master_error 

* Description  : This function is a callback function when IIC00 master 

err  

* Arguments    : flag - 

*                   status flag 

* Return Value : None 

************************************************************************** 

static void r_iic00_callback_master_error(MD_STATUS flag) 

{ 

    /* Start user code. Do not edit comment generated here */ 

    rm_comms_i2c_bus0_callback(true); 

    /* End user code. Do not edit comment generated here */ 

} 

/************************************************************************* 

* Function Name: r_iic00_callback_master_receiveend 

* Description  : This function is a callback function when IIC00 finishes  

* Arguments    : None 

* Return Value : None 

************************************************************************** 

static void r_iic00_callback_master_receiveend(void) 

{ 

    /* Start user code. Do not edit comment generated here */ 

    rm_comms_i2c_bus0_callback(false); 

    /* End user code. Do not edit comment generated here */ 

} 

/************************************************************************* 

* Function Name: r_iic00_callback_master_sendend 

* Description  : This function is a callback function when IIC00 finishes  

* Arguments    : None 

* Return Value : None 

************************************************************************** 

static void r_iic00_callback_master_sendend(void) 

{ 

    /* Start user code. Do not edit comment generated here */ 

    rm_comms_i2c_bus0_callback(false); 

    /* End user code. Do not edit comment generated here */ 

} 

 

/************************************************************************* 

Includes 

************************************************************************** 

#include "r_cg_macrodriver.h" 

#include "r_cg_sau.h" 

/* Start user code for include. Do not edit comment generated here */ 

#include “r_comms_i2c_if.h” 

/* End user code. Do not edit comment generated here */ 

#include "r_cg_userdefine.h" 
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Open t_cg_tau_user.c or r_cg_timer_user.c and add the following code. 

Declaration of external for the (sensor_name)_delay_callback() function: 

 

 

Addition of the call of the (sensor_name)_delay_callback() function to the timer interrupt callback function: 

 

 

Open t_cg_tau.c or r_cg_timer.c and add the following code. 

Define the R_TAU0_Channel0_Reset() function in the user code description part: 

 

 

Open t_cg_tau.h or r_cg_timer.h and add the following code. 

Declaration of prototype for the R_TAU0_Channel0_Reset() function: 

 

  

/************************************************************************* 

Global functions 

************************************************************************** 

void R_TAU0_Create(void); 

void R_TAU0_Channel0_Start(void); 

void R_TAU0_Channel0_Stop(void); 

/* Start user code for function. Do not edit comment generated here */ 

void R_TAU0_Channel0_Reset(void); 

/* End user code. Do not edit comment generated here */ 

void R_TAU0_Channel0_Reset(void) 

{ 

 /* function not supported by this module */ 

} 

/************************************************************************* 

* Function Name: r_tau0_channel0_interrupt 

* Description  : This function INTTM00 interrupt service routine. 

* Arguments    : None 

* Return Value : None 

************************************************************************** 

static void __near r_tau0_channel0_interrupt(void) 

{ 

    /* Start user code. Do not edit comment generated here */ 

    fs1015_delay_callback(); 

    /* End user code. Do not edit comment generated here */ 

} 

 

/************************************************************************* 

Global variables and functions 

************************************************************************** 

/* Start user code for global. Do not edit comment generated here */ 

extern void fs1015_delay_callback(void); 

/* End user code. Do not edit comment generated here */ 
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Open r_cg_main.c or r_main.c and add the following code. 

Declaration of prototype for each function: 

 

 

Addition of the following code to the main() function: 

 

 

Define of the g_comms_i2c_bus0_quick_setup() function and the demo_err() function: 

 

  

void g_comms_i2c_bus0_quick_setup(void) 

{ 

    /* bus has been opened by startup process */ 

} 

 

void demo_err(void) 

{ 

    while(1) 

    { 

        // nothing 

    } 

} 

/* Open the Bus */ 

    g_comms_i2c_bus0_quick_setup(); 

 

    /* Open FS1015 */ 

    g_fs1015_sensor0_quick_setup(); 

 

    while (1U) 

    { 

        start_fs1015_demo(); 

    } 

/************************************************************************* 

Global variables and functions 

************************************************************************** 

/* Start user code for global. Do not edit comment generated here */ 

void g_comms_i2c_bus0_quick_setup(void); 

void demo_err(void); 

 

void g_fs1015_sensor0_quick_setup(void); 

void start_fs1015_demo(void); 

/* End user code. Do not edit comment generated here */ 
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6.3.4 Modifying Sample Source Files 

Right-click on the "application" "general" "r_bsp" "r_comms_i2c_rl" "r_config" "r_fs1015_rl" folder in the 
project tree of the sample project "FS1015_RL78G14_NonOS" and select "Copy" from the context menu. 

Then, right-click on the "src" folder in the newly created project and select "Paste" from the context menu to 
paste the copied files to the folder. 

 

  

C
o
p
y
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Open r_comms_i2c_rl_config.h in the r_config folder and modify the values of the following definitions. 

• COMMS_I2C_CFG_BUSx_DRIVER_TYPE 

• COMMS_I2C_CFG_BUSx_DRIVER_CH 

When channel 0 of the serial array unit is used: 

 

 
When channel 0 of the serial interface IICA is used: 

 

For the other definitions, refer to section 5, Configuration Settings. 

 

When "serial array unit", "serial interface IICA", or "timer array unit" is used as a peripheral function name in 
the code generator, modify the sample source code as follows. 

src/general/r_smc_entry.h  

Modify "r_cg_serial.h" to "r_cg_sau.h" or "r_cg_iica.h": 

Modify "r_cg_timer.h" to "r_cg_tau.h": 

 

  

/************************************************************************* 

Includes 

************************************************************************** 

#include "r_cg_macrodriver.h" 

#include "r_cg_sau.h" 

#include "r_cg_tau.h" 

#include "r_cg_port.h" 

#include "r_cg_cgc.h" 

#include "r_cg_userdefine.h" 

/* SPECIFY DRIVER TYPE, CHANNEL NO. */ 

/* For Bus No.0 */ 

#define COMMS_I2C_CFG_BUS0_DRIVER_TYPE          (COMMS_DRIVER_I2C) /* 

Driver type of I2C Bus */ 

#define COMMS_I2C_CFG_BUS0_DRIVER_CH            (0) /* Channel No. */ 

/* SPECIFY DRIVER TYPE, CHANNEL NO. */ 

/* For Bus No.0 */ 

#define COMMS_I2C_CFG_BUS0_DRIVER_TYPE          (COMMS_DRIVER_SAU_I2C) /* 

Driver type of I2C Bus */ 

#define COMMS_I2C_CFG_BUS0_DRIVER_CH            (0) /* Channel No. */ 
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Open the "Properties" window for the project.  

Select [C/C++ Build] → [Settings] in the "Properties" window to open the "Settings" panel. 
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Select [Compiler] → [Source] in the "Tool Settings" tabbed page and press the [Add] icon. 

Press the [Workspace] button in the [Add directory path] dialog box and a list of projects will appear. Select 
the "src" folder for the newly created project in the list and press the [OK] button. 

Select the checkbox for "Add subdirectories" and press the [OK] button. 

 

 

   

  

 

Select [Compiler] → [Source] → [Language] in the "Tool Settings" tabbed page and change the setting of 
"Language standard of C language" to "C99 language standard". 
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Press the [Apply and Close] button to close the "Properties" window. 

 

 

Build the project.  

Select [Debug Configurations] from the menu and modify the debugger settings according to the 
specifications of the emulator to be connected to the target board. 
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7. Viewing Flow Data 

Use the following procedure to view flow data in real time. 

After executing debugging, select [Window] → [Show View] → [Expressions] to open the [Expressions] 
tabbed page. 
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Click on [Add new expression] on the [Expressions] tabbed page and add "gs_fs1015_data". 

 

 

 

 

Right-click on the added variables and select [Enable Real-time Refresh]. 
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Start debugging, and the values of the variables will be updated in real time. 
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General Precautions in the Handling of Microprocessing Unit and Microcontroller 
Unit Products 

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 

2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 

3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 

4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 

5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 

6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 

7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 

8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 
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Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products 
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9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific 

characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability 

product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics 

products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily 

injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as 

safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for 

aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you 

are responsible for evaluating the safety of the final products or systems manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas 

Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of 

controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these 

applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance 

with applicable laws and regulations. 

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is 

prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations 

promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions. 

12. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or 

transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document. 

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics. 

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas 

Electronics products. 

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled 
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